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This course will help you prepare to provide customer support on Microsoft Money 2007. 

This course is divided into modules.  Each module will focus on a specific topic, discussing features and methods.  In each module, you will have an opportunity to personally complete tasks in Microsoft Money 2007 and become familiar with how it is used. 
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Course Objectives

After you complete this course, you will be able to: 

· Describe the Microsoft Money 2007 SKUs available.

· Describe Microsoft Money 2007 upgrade paths.

· Create Microsoft Money 2007 files.

· Work with different types of accounts.

· Configure Microsoft Money 2007 for online services and bill payment 

Course Outline




This course is comprised of modules, each focusing on a specific set of features in Microsoft Money 2007.   Here is a brief description of what each module will discuss.

Module:  Product Overview

This module will introduce you to Microsoft Money 2007.  It will help you begin to become familiar with the program features and its functionality, as well as understand how it differs from other Microsoft Money product offerings.
Module:  Get Started with Microsoft Money 2007 

After you install Microsoft Money 2007, you must configure the program with account and other financial information. This module takes you through the steps required to get stared with Microsoft Money 2007.
Module:  Work with Accounts

This module reviews account basics and introduces account features unique to Microsoft Money 2007
Module:  Manage Your Accounts Day to Day 

In this module, you will learn the day-to-day account management and account register activities that will comprise the majority of work with Microsoft Money 2007.
Module:  Online Services and Features

In this module, you will investigate the online features and services available in Microsoft Money 2007.  You will build on the knowledge you acquired in the Microsoft Money Essentials training course.
Module:  Bills and Deposits

In this module, you will learn about bill payment and about third party bill payment providers in Money Microsoft Money 2007. 
Module:  Importing Account Data

In this module, you will learn about importing account data from your Financial Institution.

Module: Microsoft Money 2007 Account Synchronization with MSN Money

In this module, you will learn how to synchronize information between MSN Money and Microsoft Money 2007. 
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Module: Product Overview 

Objectives
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After you complete this module, you will be able to:
© Describe Microsoft Money 2007.

© Describe the difference between Microsoft Money 2007
product SKUs





This module will introduce you to Microsoft Money 2007.  It will help you begin to become familiar with the program features and its functionality, as well as understand how it differs from other Microsoft Money product offerings.

After you complete this module, you will be able to:

· Describe Microsoft Money 2007.

· Describe the difference between Microsoft Money 2007 product SKUs.

Microsoft Money 2007
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Microsoft Money 2007 helps users:

© Manage personal financial records including bank accounts, loans
and spending.

© Manage investments, including retirement savings using Portfolio
Manager.

« Track where money is spent by creating, monitoring, and managing
budgets.

« Report on tracked financial data.

« Make financial plans including debt reduction, budgets and lifetime
plans.

« Schedule recurring bills, and pay bills electronically.
« Estimate and prepare for annual taxes





Microsoft Money 2007 is the newest version of Microsoft’s personal finance application (PFM).  Microsoft Money 2007 provides new and improved features over previous versions and recreates the PFM application offering. 

Features

Microsoft Money 2007 helps users: 

· Manage personal financial records including bank accounts, loans and spending.

· Manage investments, including retirement savings using Portfolio Manager.

· Track where money is spent by creating, monitoring, and managing budgets.

· Report on tracked financial data.

· Make financial plans including debt reduction, budgets and lifetime plans.

· Schedule recurring bills, and pay bills electronically.

· Estimate and prepare for annual taxes 

Important

The Money Essentials product, released concurrently with Microsoft Money 2007, supports only new users and provides a subset of the features listed above.  You can import data from Money Essentials into 2007, providing a valid upgrade path. 
New Features

New features in Microsoft Money 2007 include:

· Savings and Spending Budget.  This is a new budgeting tool based on the 60% budget described on the MSN Money Web site.

· New Repair option.  Now you can remove all data from the Bills area, allowing to easily clear the bills data, which may be a source of corruption and or performance degradation.

· Payee cleanup.  When you archive your file, it will completely delete any previously deleted payees, instead of simply “hiding” them like previous Money versions. 

· Updated Invoice designer (Home and Business edition)

· Change Investment Type.  Allows you to change an investment from one type to another, for example changing a Stock to Mutual Fund)

SKUs

The distribution of Microsoft Money products is a follows:

· Microsoft Money Essentials (a separate Money product) 

· Microsoft Money 2007 Deluxe

· Microsoft Money 2007 Premium

· Microsoft Money 2007 Home & Business (formerly Money Small Business)
Note

See Appendix A for detailed list of Money SKUs.

Feature Comparison

	Feature
	Essentials
	2007 Deluxe
	2007 Premium
	2007 Home & Business

	Checkbook balance
	
	X
	X
	X

	Track spending
	X
	X
	X
	X

	Download transactions
	X
	X
	X
	X

	Organize bills
	X
	X
	X
	X

	View charts and reports

(reports available vary by version)
	X (Very minimal and limited customization.)
	X
	X
	X

	Track credit and debt
	X
	X
	X
	X

	Forecast cash flow
	
	X
	X
	X

	Plan for retirement
	
	X
	X
	X

	Export tax data
	X
	X
	X
	X

	Estimate taxes and find deductions
	
	X
	X
	X

	Estimate tax withholding
	
	X
	X
	X

	Manage 401K
	
	X
	X
	X

	Tax-smart investing
	
	
	X
	X

	Automate Schedule D tax reports
	
	
	X
	X

	Minimize capital gains taxes
	
	
	X
	X

	Small business invoice generation
	
	
	
	X

	Small business graphs and reports
	
	
	
	X

	Online small business payroll management
	
	
	
	X

	Track schedule C items
	
	
	
	X

	Monitor accounts receivable
	
	
	
	X


Review
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In this module, you learned to:
© Describe Microsoft Money 2007.

© Describe the difference between Microsoft Money 2007
product SKUs.





In this module, you learned to: 

· Describe Microsoft Money 2007.

· Describe the difference between Microsoft Money 2007 product SKUs.

Module: Get Started with Microsoft Money 2007 
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Overview
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© Start Microsoft Money 2007.

© Use the Setup Assistant and create a new Microsoft
Money 2007 file.

© Convert a Money Essentials file.





After you install Microsoft Money 2007, you must configure the program with account and other financial information. This module takes you through the steps required to get stared with Microsoft Money 2007.

In this module, you will learn to: 

· Start Microsoft Money 2007.

· Use the Setup Assistant and create a new Microsoft Money 2007 file.

· Convert a Money Essentials file.

Start Microsoft Money 2007 
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Setup Wizard starts automatically, and steps you through
the following procedures:

Determine location for the new Microsoft Money 2007
file.

Acceptance of the advanced features provided by
Windows Live ID.

Privacy and security method (Windows Live ID or
password configuration).

Account setup.





Now that you have installed Microsoft Money 2007, begin to use the product. Like Money Essentials, Microsoft Money 2007 can be started by the desktop or Start menu shortcuts that are installed by default. 

Microsoft Money 2007 Online Services Policy 

When you first start Microsoft Money 2007, the Microsoft Money 2007 Online Services Policy appears.  This policy is very similar to the one presented in Money Essentials, and clearly explains that Microsoft Money 2007 includes two years of Money-related Internet services, from the time of activation.  To begin using the product, you must accept the terms of this policy.

Note

Money Essentials only provides one year of Money-related Internet services.
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After accepting the policy, the setup Wizard appears. You can also access the setup Wizard when you create a new Microsoft Money 2007 file.   

Tip

The file creation process is very similar to that of Microsoft Money Essentials.
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Password or Live ID 

When creating a new Microsoft Money 2007 file, you can use or create new Windows Live ID credentials.  If you select I want to set up a new Windows Live ID, Internet Explorer will open at the Windows Live ID creation web site. 

You can also use a local password to secure your file. Microsoft does not recommend this option because there is no support for forgotten or lost password recovery. 

Tip

If you sign in using an existing Windows Live ID, and you have account data stored on the MSN Money servers, a window will be displayed, asking Do you want to use your MSN Money My Accounts data?. If you  click Yes, a list of all the accounts you have stored on the MSN Money servers will be displayed.  If you click No, a new Money file is created without using any data stored on MSN Money servers. 

At this point, you can add one of the following account types to the file: 

	Account Type
	Details

	

	Banking
	Banking encompasses savings and checking accounts and the use of a debit card. A debit card is a card issued by a bank that can be used for making purchases and obtaining cash. When a debit card is used the money comes directly out of the checking account. You do not receive a bill and cannot carry a negative balance.

	Credit card
	Credit cards are short-term loans made by the credit card company. When you purchase something using a credit card, you are promising to pay for it in the future.

	Investment
	Investment accounts include such things as stocks, bonds and mutual funds.


Note

After you have completed the file setup wizard, you can add accounts using the File, New , New Account menu option. This option also allows you to create Bill payment service provider, or other account types.
Convert a Money Essentials File 
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If you have a Microsoft Money Essentials file that contains data you would like to use in Microsoft Money 2007, Microsoft Money 2007 can convert it for use in this version of Money.  After you convert the file, Microsoft Money Essentials will no longer be able to open the file. Microsoft Money 2007 automatically creates a backup of the original Microsoft Essentials file using the .MNE filename extension. 

To convert a Microsoft Money Essentials file, follow these steps:

1. In Microsoft Money 2007, on the File menu, click Open.

2. Locate the file you want to convert and click Open.
3. On the Converting a Money Essentials dialog box, click OK.
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Review
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In this module, you learned to: 

· Start Microsoft Money 2007.

· Use the Setup Assistant and create a new Microsoft Money 2007 file.

· Convert a Money Essentials file.
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Module: Work With Accounts 
Overview

When working in Microsoft Money 2007, the basic tool for managing your financial information is the account.  This module reviews account basics and introduces account features unique to Microsoft Money 2007. 

In this module, you will learn to: 

· Discuss the different types of Microsoft Money 2007 accounts.

Microsoft Money 2007 Accounts
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Account Type Details
Banking Use for bank accounts such as, checking
and/or savings accounts
Credit card Use to track transactions, balances, and
interest rates on credit cards or Line of
Credit accounts.
Investment

Use to record your investments in stocks,
bonds, mutual funds, and other securities
(Personal Accounts only)

Bill Payment Service Provider

Allows you to add a bill payment
method, such as CheckFree (for existing
users only) or MSN Bill Pay.

Other account type

This account type allows you to track
loans, asset or watch accounts.





As you learned in the Money Essentials course, an account is a group of transactions in Money. Each account reflects a single bank, investment, or credit card account.  

Microsoft Money 2007 includes the Other account type. 

Tip

The Other account type is not available in Money Essentials.

Microsoft Money 2007 supports the following types of accounts:

	Account Type
	Details

	

	Banking
	Use for bank accounts such as, checking and/or savings accounts

	Credit card
	Use to track transactions, balances, and interest rates on credit cards or Line of Credit accounts.

	Investment
	Use to record your investments in stocks, bonds, mutual funds, and other securities (Personal Accounts only)

	Bill Payment Service Provider
	Allows you to add a bill payment method, such as CheckFree (for existing users only) or MSN Bill Pay.

	Other account type
	This account type allows you to track loans, asset or watch accounts.

A loan account includes amortized loans such as, home, car and school loans, whether your are the borrower or lender 

An asset account deals with home, real estate, personal property, or amounts owed to you on non-interest bearing loans to provide a more complete financial picture.




Tip

If you want Money to have more detailed information for calculating this year's taxes, enter your starting balance for each account from the first of the year and enter all of this year's transactions for each account. 

This feature is available if you are setting up accounts in the Advanced Account Register, which will be discussed in more detail in the upcoming Manage Your Accounts Day To Day module. 
Review

In this module, you learned to: 

· Discuss the different types of Microsoft Money 2007 accounts.
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Module: Manage Your Accounts Day to Day

Overview

In this module, you will learn the day-to-day account management and account register activities that will comprise the majority of work with Microsoft Money 2007.

After completing this module, you will be able to:

· Work with the Account Register.

· Describe the different register views.

Account Register
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As with Microsoft Money Essentials, the account register is where all transactions for a particular account are stored in an itemized fashion. The register is where you enter transactions, pay bills and categorize spending. 

The easiest way to keep the register up to date is to use online updates from your bank or brokerage. Microsoft Money 2007 automatically categorizes the transactions, if it recognizes the payee. You can then add more detailed information or re-categorize the transaction. You can also update your accounts by manually typing in your transactions. 

Register Views

The Account Register in Microsoft Money 2007 provides you two ways to look at accounts, the Essentials Register and the Advanced Register. You can switch between the two Account Registers depending on what you are doing and how much detail you want.

Essential Register
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The Essential Register is a version of the account register for accounts that are updated online, which gives you streamlined access to your balances and transactions without requiring you to do detailed tracking or balancing. The Essential Register provides you with the basic information about current account balances and transactions. With the Essential Register you can:

· See balances and transactions for all of your accounts, updated online

· Automatically put spending into categories for tracking

· Add information about checks that have not cleared the bank yet

To use the Essential Register, your account must be set up for online banking. This will be the default for any new accounts that are set up for online banking. 

Advanced Register
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The Advanced Register emphasizes detailed tracking of individual expenditures. It can be updated either online or manually. Most previous Money users are familiar with the Advanced Register.  The Advanced Register can involve more work keeping register information current.  With the Advanced Register, in addition to the Essential Register tasks, you can:

· Assign detailed categories and subcategories to transactions

· Itemize a transaction by splitting into different categories

· Track paycheck taxes and deductions

· Balance your accounts against a statement

Remember

Microsoft Money Essentials does not support the same register views as Microsoft Money 2007. You will not find the Advanced Register view in Microsoft Money Essentials.

Review

In this module, you learned to: 

· Work with the Account Register.

· Describe the different register views.
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Module: Online Services and Features 
Overview
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© Explain how to configure Microsoft Money 2007 for
online banking.

© Configure automatic balancelireconcile.





In this module, you will investigate the online features and services available in Microsoft Money 2007.  You will build on the knowledge you acquired in the Microsoft Money Essentials training course. 

After completing this module, you will be able to:

· Explain how to configure Microsoft Money 2007 for online banking.

· Configure automatic balance/reconcile.

Online Banking
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Microsoft Money 2007 includes a number of powerful financial management tools powered by the Internet, known as online banking. With online banking, you can connect to your financial institution to keep your bank statements up-to-date, and pay bills. 

Online banking uses services provided by your bank or brokerage to do common banking tasks, such as paying bills, on the Internet. 

With online banking, you can quickly download all of your transactions and keep your Money file up-to-date even if you forget to manually enter a deposit or withdrawal. Before you can download transactions, you must enable online banking in Microsoft Money 2007 and with your financial institution.
Setup

The first time that you connect to a bank or broker using Microsoft Money 2007, your information is downloaded. If you have not already created the corresponding accounts in Microsoft Money 2007, you will be prompted and lead through the process to add the accounts to your Money file.
Before you can enable online banking, you must inform your financial institution that you want to use online baking. This may simply be setting up online services on the financial institution’s web-site. But, if the FI provides direct services into Microsoft Money 2007, it may require having them enable this service. 

Remember

To determine if your bank provides services to Microsoft Money 2007 users, go to the List of Supported Financial Institutions (FI) at: http://www.microsoft.com/money/bankonline.aspx 
The service offerings listed will only determine whether or not the FI offers free direct services. It is possible that the FI offers direct services and are not listed that way here. If this is the case, this would indicate that they offer them at a fee to the customer. We do not separate these financial institutions from the list. If a customer needs to know whether or not their FI offers direct services for a fee, please have them contact their FI

Account Updates

With Microsoft Money 2007, you can update your accounts using online information, or you can type in your transactions yourself.  Account updates can be completed the following three ways: 

· Online updates. This is the fastest, simplest way to keep your balances up to date. Money updates your accounts with the latest information from your banks and brokerages. You can update your accounts whenever you choose, or Money can update your information automatically according to a schedule you set up.
This is the method we will discuss in this module.

· Imported bank account information. Some banks don't provide online updates directly to Money, but you may still be able to update your accounts by downloading statements from your bank's website. When you set up your accounts in Money, Money adds your bank's website to your list of favorite websites on the Money Favorites menu.
· Typing in your transactions manually. You can enter the information yourself. If you also use online updates in an account where you've entered transactions, you should review your account after each update to make sure there aren't duplicate copies of transactions.

Automatic Account Updates

With automatic account updates, also called background banking, Microsoft Money 2007 regularly downloads up-to-date account information. With some banks, Money’s automatic updates occur every day. With other banks, you can set up Money to get updated account information at regular intervals, such as weekly or monthly. These less frequent intervals may be useful if your bank charges you a fee to use Money to view your account information.
To use automatic online updates, both of the following configurations must be made: 

· Save your bank sign-in information in Money. Otherwise, you will need to enter an account's sign-in information every time you want to update the account. (Some banks will automatically save your sign-in information.) 

· Sign in to Money with your Windows Live ID. If all of your banks' sign-in information is saved in Money, your unique Windows Live ID (An online service that enables you to use your e-mail address and a single password to sign into any service or website that uses Windows Live ID.) helps protect your account information from being accessed by others.

Tip

When adding a new account to Money, you can set up automatic updates as you set up the account.

To set up automatic updates, follow these steps, if you have not yet completed the online setup for your accounts:

1. If you haven't yet done so, sign in to Money using your Windows Live ID.
2. On left side of the Account list page, click Manage online services.
3. Next to an account, click Complete setup for online services, or Check for new online services.

4. Follow the instructions on the screen. 

5. When you enter your bank or brokerage sign-in information, you must select the Remember this password box.
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If you have already enabled online services for your accounts, follow these steps to enable Automatic updates:

4. Sign in to Money using your Windows Live ID.
5. Click Tools, and then click Internet Updates and Customize Updates.

6. Follow the instructions listed for your financial institution.  

7. If you have not asked Money to save your financial institution password, click on the link to provide a password.

8. If you have previously assigned a password, you can set an update interval.

9. Click on OK after you are finished.

Balance an Account
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Balancing occurs when you verify that all of the transactions shown on your statement are properly recorded in Microsoft Money 2007 and that the balances according to the current statement and account register agree. 
Tip

Balancing an account is also called reconciling your account.

There are two ways to balance an account against a statement:

1. You can automatically adjust an account balance to match the bank's balance by having Money do it for you.
2. You can manually balance an account against a statement by reviewing every transaction in the statement.
Important

You must be using the Advanced Account Register to balance an account. 
Automatic Balance

If you've set up online account updates for a bank account, a credit card account, or a cash account for an investment, Money can automatically adjust the account balance to match the balance shown on your bank or brokerage statement. First, you'll need to accept all downloaded statement transactions for the account before Money can automatically adjust your account balance.
You can choose to have Money do one of the following things to make your ending balance match your bank or brokerage balance:
3. Adjust your opening balance if it is currently zero.

4. Enter an account adjustment transaction that will be flagged for you to follow up on later at your convenience.

Manual Balance
To manually balance your account, you need to have your account statements available. 

Note

When you update your accounts online, an E (for electronic) appears in the C (cleared) column. After you balance your account, the E changes to an R (for reconciled).

1. Click Banking tab to open the Account List.
2. Click the name of the account you want to balance. 

3. In the left pane under Common tasks, click Balance this account. 

4. In the Statement date box, enter the ending date shown on your statement. 

5. In the Ending balance box, type the amount shown on your account statement. The amount in the Starting balance box is the ending balance from the last time the account was balanced. 

6. Enter any service charges or interest earned during this balance period, and then click Next. If you use online updates, don't include any charges or interest that have already been recorded by an online update. 

7. Compare the transactions on your statement with those in your Money account register. For each transaction:

· That matches between the statement and the register, click the C (cleared) column to mark it as cleared. 

· If a transaction was entered incorrectly in the account register, click the transaction, and then make the correction. 

· If transactions appear on your statement but not in your account register, click New, enter the transaction details, and then click the C column to mark it as cleared.

8. The left pane shows your cleared account register balance and the bank statement balance. When the difference between these balances is zero, your account is balanced. 
9. In the left pane, click Next, and then follow the instructions on the screen.
Tip

If you cannot finish balancing a bank account, click Postpone.  Microsoft Money 2007 will remember which transactions you have already marked as cleared when you return to balance. 
Review
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In this module, you learned to: 

· Explain how to configure Microsoft Money 2007 for online banking.

· Configure automatic balance/reconcile.

Module: Bills and Deposits 
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Overview
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After completing this module, you will be able to:

© Describe how to pay a bill in Microsoft Money 2007.
© Create and modify a recurring bill.

© Add a deposit.

© Describe online bill payment

© Review third-party bill payment.

© Print checks in Microsoft Money 2007.





In this module, you will learn about bill payment and about third party bill payment providers in Money Microsoft Money 2007.

After completing this module, you will be able to:

· Describe how to pay a bill in Microsoft Money 2007.

· Create and modify a recurring bill.

· Add a deposit.

· Describe online bill payment 

· Review third-party bill payment.

· Print checks in Microsoft Money 2007.

Bills and Deposits
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Like Microsoft Money Essentials, Microsoft Money 2007 has a set of tools to help you manage you bills and deposits: however Microsoft Money 2007 provides two options, Essential Bills and Advanced Bills.

Essential Bills

Essential Bills is the streamlined deposit, bill scheduling and payment setting that most users prefer. It offers all the tools you need to quickly and efficiently manage your deposits bills. You don't have to spend time tracking account details, so it's easy to pay both your recurring deposits or bills and regular events.

With Essential Bills you can:

· Edit and pay multiple bills at one time. 

· Keep track of all your bills. 

· View all of your scheduled bills in a list on the Bills summary page, or for the entire month on the bill calendar. 

· Work directly from the bill calendar. 

· Set up recurring automatic payments (Apays). 

· Categorize your bills to help with budgeting.

· View a history of electronic and manual payments. 

· Split categories within a single payment.  

Advanced Bills

Advanced Bills offers all the same basic features of Essential Bills, plus additional features providing more detailed control over your deposits, bills, bill tracking, and bill payment. Note that Advanced Bills does require additional setup and management time.

With Advanced Bills, in addition to using all of the Essential Bills features, you can:

· Add recurring deposits, transfers, paychecks, and investments. 

· Edit a single bill occurrence. 

· Make electronic transfers. Set up automated transfers between any accounts you track in Money. 

· Specify when a bill series will end. 

· Print checks. 

· Save draft payments to send later. If you are missing some bill details, you can save a draft payment and finish it later.
Switch between Essential Bills and Advanced Bills

10. On the Tools menu, click Settings. 

11. On the Microsoft Money 2007 settings page, click Bill settings. 

12. Depending on your current setting, choose one of the following: 

13. Click switch to Advanced Bills, and then click Use Advanced Bills.
OR
Click switch to Essential Bills, click Use Essential Bills, and then click Yes.
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14. Click OK.

Tip

To determine whether you're using Essential or Advanced Bills, look for the Essential Bills or Advanced Bills label in the upper-right corner of the Bills summary page.

Record a Bill in Advanced Bills




To record a bill in Advanced Bills
15. On the Bills summary screen, click New.

16. Click Bill.

17. On the Create recurring bill page, enter the information about the transaction, and then click OK.
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Note

On the Create recurring bill page, you can create a bill that occurs only once, or at a variety of other frequency intervals.
Deposits
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To add a deposit, follow these steps:

Note

To perform this advanced task, you must be using Advanced Bills.

18. On the Bills summary screen, click New.

19. Click Deposit.

20. On the Create recurring deposit page, enter the information about the transaction, and optional recurrence information, and then click OK.

Online Services and Online Bill Payment 
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Online services and bill payment provide fast, secure recordkeeping transactions, payments, and saves money on stamps and trips to the post office. In addition, since the information is entered directly into Money, the chance of data entry errors is reduced and the information in the account is always current.

Online Bill Payment

With online bill payment, you can:

· Make online payments to anyone that you'd normally pay by check. 

· Schedule your bills to be paid on the date they’re due. 

· Set up automatic payments.

· Store information about all of your payees online. 

Important

Online bill payment features vary, depending on your bank. Some banks don't support online bill payment in Money, but they may allow you to pay bills from your bank's Web site instead.

To pay your bills online in Money, you must first sign up for online bill payment service with either your bank or with a bill payment service provider. Many banks provide this service. Check your bank's website for more information on whether they offer this service for use in Money, and how to sign up.

When you enter online sign-in information from your bank in Money, all the bank services associated with the account are automatically set up, including online bill payment. Once you've set up online bill payment with your bank or with a bill payment service, check for the service in your existing Money accounts, and update them if necessary.
Tip

If you set up an online account in Money using the sign-in information from your bank, all the services associated with the account are automatically set up, including online bill payment.

Set Up or Update Online Services

To set up or update online services, follow these steps:

21. Click Banking, and then click Account List. 

22. In the left pane under Common tasks, click Manage online services. 

23. Look for the name of the bank or provider where you signed up for online bill payment service. If it's listed under You have set up online updates at these banks and brokerages, see if Online bill payment is listed under Services for that bank or provider. 

If it isn't, choose the appropriate method below:

a. If it's listed under You have set up online updates at these banks and brokerages, then click the name of the bank. 

b. Under Use online services, click Update accounts and other information online. 

c. Under Account transactions, select the check box for the account that you want to pay bills from, and then enter the sign-in information that you use on your bank's website. 

d. Click Update.  

OR

e. If it's listed under You haven't set up online updates with these banks and brokerages 
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f. In the To Do column for the bank, click Complete setup for online services. 

g. On the Account Sign Up screen, click Accept.
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h. You may be prompted if you have sign-in information for the account. Click Yes, I have sign-in information, and then click Next.
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Remember

To complete online setup in Money, you must have online banking sign-in information from your bank or brokerage.  Some banks and brokerages require that users specifically request access to their accounts for Microsoft Money 2007.  
i. On the Enter your sign-in information page, complete the form and then click Next.
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j. The Getting account information screen appears.
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k. On the Match accounts page, select to match or create a new Microsoft Money 2007 account, and then click Next.
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l. On the Choose account update settings page, configure your download options, and then click Next.
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m. Click Done
Bank Not Listed for Updates

If the bank or brokerage is listed under These banks and brokerages do not provide automatic online updates, follow these steps:

1. Under the To Do column, click Check for new online services.  

2. Select type of account and then the bank from the list of banks and brokerages, and then click Next.
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3. You may be prompted to configure Microsoft Money 2007 for Windows Live ID. Click Next  to continue.
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4. On the Advantages of MSN Money My Accounts page, click Next.
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5. On the Congratulations screen, click Finish.

6. You may be asked about your Internet connection. 
Additional Online Setup Considerations

When you setup online services, if your account listed under either heading (have or haven’t setup online updates) contains the name of the bank or provider where you signed up for online bill payment services, you need to set up an account in Money with that bank or service provider 

Advanced Account Setup

On the page where you initially enter your sign-in information during online setup, you may be given the option to complete Advanced Account Setup. 
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Choose this option if you know that you want Microsoft Money 2007 to skip downloading transactions for one or more of the accounts that your bank or financial institution would normally download during online updates.

For example, if you have two different user names that you use to access a joint bank account online in Money, the account may be listed twice in the account list. Choose the Advanced Account Setup option to have Money give you the choice to skip downloading transactions for a specific account during online updates. 

Online Bill Payment Provider

An online bill payment provider is a third-party service that allows you to pay your bills over the Internet. 

Online bill payment providers for Microsoft Money 2007 currently include MSN Bill Pay, administered by CheckFree.  Microsoft Money 2007 also provides existing customers of CheckFree’s bill payment service to continue paying bills in Money. 

Note

The third-party online bill providers available in Microsoft Money 2007 may change. 

To add an online bill payment provider, follow these steps:

1. Under Account tools on the Banking page, click Manage Online Services. 
2. Under Online bill payment providers, click View list of providers who work with Money.
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3. On the Select bill payment service provider page, click the provider and then click Next.
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4. You will then follow the instructions on the screen to provide the appropriate sign in information for that service provider. 

Third-Party Bill Payment 
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MSN Bill Pay

MSN Bill Pay lets you pay your bills online through Money. You can pay virtually anyone in the United States that you would normally pay by check or automatic debit; even if you do not receive bills from the company or person you want to pay.
Using MSN Bill Pay you can:

· Review some of your bills online using the MSN Bill Pay Web site. 

· Set up automatic payments to pay your electronic bills or to automatically schedule payments of a set amount at regular intervals. 

· Review your bills and payments for the past six months.

· Transfer money and move payments from one account to another.
Note

Users may have an account with MSN Bill Pay, but have no other online services.  Payments made via MSN Bill Pay will be shown as adjustments because data is not downloaded from the actual financial institution, and these payments will remain uncleared.
Windows Live ID and MSN Bill Pay

Windows Live ID is no longer used for authentication and access to your MSN Bill Pay data. CheckFree now provides all MSN Bill Pay authentication. 

Note

For more detail on MSN Bill Pay, refer to the Microsoft Money Essentials course.

Print Checks 
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Using Money to print checks can save you time when paying bills, especially if you print multiple checks at once. Money prints the check information on special blank, pre-printed, checks you can purchase. These checks are just like personal checks you buy from your bank. They are accepted everywhere checks are accepted.

When printing checks, you have many options, such as which checks to print, the size of the check, the check number you begin with, and how many checks to print per page. You can print test checks to verify that the alignment is correct and even choose the font size and type on your checks.

To print checks in Microsoft Money 2007, follow these steps:

24. Place the Microsoft Money 2007 checks in your printer.

25. Click Banking, and then click Account List. 

26. Open the account that will contain the transactions for the checks you want to print. 

27. To enter a new transaction, click New. To edit an existing one, click Edit. 

28. In the Number box, select Print this transaction, and then click Enter. 

29. If the Print Address dialog box appears, enter the information, and then click OK. 

30. On the File menu, click Print checks. 

31. Set the options you want, and then click Print.

Note

Microsoft Money 2007 will not print checks on plain paper. To order checks for Microsoft Money 2007 via the Microsoft partner DELUXE, visit the Microsoft Money website, or call 1 (800) 432-1285.

Review
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In this module, you learned how to:

· Describe how to pay a bill in Microsoft Money 2007.

· Create and modify a recurring bill.

· Add a deposit.

· Describe online bill payment 

· Review third-party bill payment.

· Print checks in Microsoft Money 2007.

Module: Importing Account Data
Overview

In this module, you will learn about the repair tools included with Microsoft Money 2007, and how they can help you assist customers in recovering their data. 

After completing this module, you will be able to:

· Import data from a bank statement. 

Demonstration: Importing Accounts into Microsoft Money 2007 
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Two methods of importing data are available in Money 2007. The first is to Import as a New or Recovered account. This method is used when you are creating a new file or importing into a new account.  

The other method is to Import as a Statement from the Bank. This method is used if you are trying to “merge” two accounts together or if you want to verify each transaction before it is entered.

How to Import Accounts as New or Recovered accounts

1. Open the copy of your Money file.

2. Create a new account with an opening balance of zero for each account you exported plus one additional account called Temp. (The names will need to be slightly different.  For example:  If you already have an account called Bill’s Savings, maybe you would like to call it Savings – Bill)

Note

If you exported multiple accounts from another version of Money, you should create all of these new accounts with zero balances before you proceed to step 3 to avoid problems with your transfer transactions. You can delete unwanted accounts later.

3. Close all the accounts in the file except for the new ones just created.

4. On the File menu, point to Import, and then click Recover Accounts.

5. In the list of files, click the QIF files that you want to import. To select multiple files, press and hold down CTRL as you click to select each file. 
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Note

If you want to import multiple accounts into your new Money file, you must import all of the files at the same time to avoid problems with your transfer transactions. You can delete unwanted accounts later.
6. Click Import.
7. In the Select Import dialog box, match the QIF file with the appropriate account, and then click OK. Repeat this step for each QIF file you are importing.
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Note

Read each Select Import dialog box very carefully to learn what information you are importing, and where you are assigning the information in Money. You may be prompted to assign transfers to another account. If so, assign them to the Temp account to prevent duplication of transactions in the other accounts.

8. When Money finishes importing the files, click OK.
9. Now reopen the accounts that were closed and you can delete the Temp account.

Import QIF or OFX Data Files as Bank Statements
A QIF file is a specially formatted text file that’s used to transfer data between financial programs. Importing QIF files is a convenient way to enter transactions into Money without having to retype the information. You can reconcile transactions in your Money account with transactions in your imported QIF file. Reconciling prevents: 

· Duplicate transactions 

These occur if you've already entered transactions into your Money account and then import a QIF file containing the same transactions. They can also appear if importing a recovered account and you import transfers into an existing account. When reconciling, you can view and remove these duplications.

· Transactions imported as cleared before reconciling 

These can also occur if a QIF file is imported after your bank statement is printed (for example, the QIF file may have cleared transactions that aren’t on the bank statement). When you reconcile your Money account with the imported QIF file, mark the imported transactions as unreconciled. This will help you if you choose to balance your account with your bank statement.

· Account balance not available 

The QIF file format does not include account balance information. Money will be unable to display a balance for these statements.

Import a QIF or OFX File

10. On the File menu, point to Import, and then click Downloaded Statement.

11. In the Import a File dialog box, select the file that you want to import, and then click Import.

12. You must select a Money account for your imported file. You have the option of creating a new account if the data that you are importing does not belong in an existing account.
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13. Click Next to complete importing the data, or click Import Later to complete this step at a later date.

Review

In this module, you have learned how to:

· Import data from a recovered file and from a bank statement.
Online Resources

· Microsoft Money 2007 includes comprehensive online help documentation for using the product. 

· Money Tour Videos are included to quickly orient users to the product.

· The online user guide walks users through common tasks.  To view the guide, visit: http://www.microsoft.com/money/support/support_manual.mspx 

Note

The 2007 version may not yet be available, however the Money 2006 online users guide is still helpful.
· A very useful glossary of general financial terms is available online at:

http://moneycentral.msn.com/taxes/glossary/glossary.asp?Letter=@
